
PowerPoint  
 

 

Open PowerPoint, Note the options to choose from predesigned templates or blank presentation.  Choose 
Blank Presentation.   
Create a presentation on your Social Business plan.  The first slide of the presentation is normally the title 
slide, with the name of your Presentation and subject content.  Click in the box provided to type in your 
title. 
To insert a second slide, choose New Slide from the HOME tab, Slides group ( Note the other options on 
the Slides group to Adjust the Layout, Reset the Slide and Insert a Section).  The 
drop down arrow on the New Slide icon presents us with different Slide Layouts.  
Select a slide layout with placeholders for Title and Content.  
 
Create slide 3, and choose the New Slide Layout with “Two Content”.   

Insert your heading, type for the Left hand content;  for 
your Right hand content, note the options for additional 
content other than text in the centre of the placeholder 
as watermark icons.  To view each option, move your 
mouse over each icon.  This time we will use the Pictures 

option, the Insert Picture box allows you to browse to find your image.  Insert 
an image from the images folder 
Insert another slide layout with “Two Content”.  Insert the Title;  and include 
text for your bullet points type in; Insert another Image this time using Online 
Pictures, the Insert Picture box provides you with a Bing Image Search.  Type Enterprise and press enter.  
Note in the result images are licenced under Creative Commons, it is important using images to reference 
the source.  Pick your image and click insert.  As Word, the contextual tab Picture Tools appears to allow 
you to adjust the image.   
If you want to adjust the Slide Layout after you have created the slide, from the Home tab, choose  a 
different Layout option from the Slide group.   
To adjust the Font of the text as in MSWord, choose an option in the Font group on the Home tab.   The 
arrow on the right hand corner of the Font group opens a Font dialog box.   
 
Save your presentation 
Choose Save As from the FILE Menu.  Note the option to choose a different file format in the Save as Type 
box.  Type the name of the file in the File name box.  Save to your OneDrive or Memory stick.  Click Save 
 
PowerPoint’s Views  
From the VIEW tab look at the different presentation views.   
Normal : Shows the Slides tab in thumbnail sized slides, each Slide and Notes view (to view notes see if 
the show notes is selected on the VIEW tab Show group / Notes.) The thumbnails on the LHS of the view 
make it easy for you to navigate through your presentation and to see the effects of formatting and allow 
you to rearrange, by dragging slide thumbnails, add, or delete slides.   
Working in Outline View 
If you are working on the Title of a slide when you press ENTER a new slide is produced.  
If you are working with bullets, ENTER brings to the next bullet.   
To create some body text for the slide, press the TAB key to move in a level.  To promote a point, press 
SHIFT+TAB.   
Practice adjusting the presentation information using this outline view.  This view allows you to move 
content easily from slide to slide and to create new slide with bullet points in slides.   You can also right 
click in Outline view to get a drop down menu that allows you to adjust slides.   
Slide Sorter : Shows all the slides in the presentation in miniature on the screen.  To move slides in 
Slide Sorter, click the slide icon of the slide you want to move and drag it to where you want to move it.  A 
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vertical line represents the slide as it moves, release the mouse button to place the slide in the new 
location. 
Notes Page :  presents your slide and any notes you have typed.  
Reading View  : Use Reading view on your own computer when you want to view a presentation not in 
full-screen Slide Show view, but in a window with simple controls that make the presentation easy to 
review. 

Icons on the bottom right hand corner of presentation also give you these views  
Slide Show : Allows you to see the slides, as you would present them in full screen mode, without 
Toolbars in view.  Select the first slide of the presentation.  Click the Slide show button .  The first slide 
appears on your screen in full screen view.  Click with your mouse or press return to move on to the next 
slide.  Press Esc to exit the slide show prematurely if necessary. Practice using the different views.   
 
Apply a Design to your slides 
Choose the Design tab, the Themes groups presents you with various schemes.  The more arrow at the 
right side of the Themes presents you with other design options.  

Browse the different designs and to load the design on the slide, click the theme icon.  This Design will 
apply to all your slides, changing colour schemes of charts and tables if you have any in your Presentation.  
If you want to Edit the colour, fonts and effects of a theme the Variants group allows 
you to select different Built-in options. Click the drop down arrow to choose different 
Colors, Fonts, Effects and Backgrounds for your theme.   
If you want the Theme to only apply to certain slides, select the slides you want to 
adjust and right click the Theme to get the drop down menu with the choices of slides 
you can apply the theme – All Slides or Selected Slides.    
 
Format Background task pane allows you to edit the background of slides. Practice 
adjusting the slide background and note the options to insert a Picture as your slide 
background, adjust the Transparency of the image and apply to the selected slide or 
Apply to All slides.   
There is also the option to remove or Hide background graphic of the theme, if you just 
want a plain slide.   
 
Slide Transitions allow you to set motion effects between slides in your presentation. 
On the TRANSITIONS tab, the Transition to This Slide group, click the effect to preview 
the Transition.  You can control the timings, add sound, and adjust the effects.  Insert 
different Transitions to view the effects.   
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Inserting Hyperlinks  
1. Select the text, picture or drawing object you want to display as the hyperlink.  
2. Click Hyperlink on the INSERT tab. 
3. From the dialog box choose where you 

want to link the file to, a File, URL or to 
a location in the file you are working 
on. 

4. To link to a file:  In the Address box, 
enter the path of the file you want the 
hyperlink to jump to, or click the drop 
down list in the Look in Box to find the 
file. 

5. To link to a web page:  Type in the full 
address of the page. 

6. Click the Screen Tip button and insert a screen tip on the link. 
7. Choose OK and the link is created to a file or URL outside the presentation.  The link will only open in 

Slide Show view, click the link to open it in the slide show. 
8. You can also create links to a place in the same presentation, click Bookmark… or Place in This 

Document and select the Place in the Document or click the slide you want to navigate to, click OK.  
Click the link in slide show view to activate. 

9. You can also insert hyperlinks by using Action icon on the Links group 
of the INSERT tab.  The Action Settings dialog box gives you choices to 
link to slides, run programs or other files using on mouse over or 
mouse click.   

10. Browse to the find the program or file you wish to link to and click OK.   
 
Action Buttons 
You can insert Hyperlinks on any 
shapes using Insert Hyperlink or Action.  Action buttons at the bottom of 
the INSERT / Shapes, choices launch the Action Setting dialog box when 
you draw out the shape.    

 
 Playing video clips in your presentation 

1. On the HOME tab, click New Slide and choose Title and Content 
layout and choose the Insert Video option.   

2. Video From File: Choose Browse From a file to find the movie 
file, click the file and OK.   
The movie is inserted into your presentation. The Video Tools 
tabs allows you to adjust the video settings.  The Format tab 
allows you to adjust the Color, Poster Frame, change the 
Style, Shape, Effects… 

   
The Playback tab allows you play the movie and mark various bookmarks points so you have the 
option to play the movie from that point.   
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In the Editing group you also have the feature to trim your movie by dragging the starting point to 
where you want your video to start and drag the end point where you want the video to end and click 
ok.  The video is now trimmed to your specified length.   
The Video options group allow you to adjust the start settings and loop the video.   

3. Video from YouTube search for the video and click insert. 
4. Video Embed Code: to get the embed code for a video in YouTube or other video provider- Click the 

Share Option, Choose Embed and copy all the code - the iframe width …… paste into the embed 
space… note the code should be in the iframe format and not object format) (You can edit the code and 
get the video to start after so many seconds- after the ? in the code remove rel=0 and change to 
start=30 if you want the video to start 30 seconds in.  (If there is no ? and rel=0 in the code add 
#t=2m30s before the end “)) 

5. You can also insert a movie or audio from the INSERT, Media group note the options - Video ( Online 
Video or Video on My PC) or Audio (Online Audio or Audio on My PC or Record Audio)  

Animation 

 
To control the points or images on your slides you can give them different animation effects.   

1. Select the text or image you wish to animate and choose the ANIMATIONS tab. Click any of the 
Animation options visible or click the drop down arrow to view more options: Entrance, Emphasis, 
Exit or Motion Paths.  The Add Animation drop down menu provides additional choice.   

2. The Effects options drop down menu allows you to change direction of your animation. 
3. The Advanced Animation group allows you to Add another animation to the object, view the 

Animation Pane, insert Triggers and Use Animation Painter.   
4. The Timing group allows you to control to start time and order your timings.    
5. Open the Animation Pane, to show you what effects you have chosen and 

this pane allows you to edit / modify each one, the animation start settings, 
Direction and Speed.  Can also change the order and re-order the animation.                                

6. To refine the animation, click the dropdown arrow and from the menu, note 
the options.  Start on Click, Start With Previous, Start After Previous, Effect 
Options, Timing, Show Advanced Timeline and Remove. Choose Effect 
Options, the dialog box below allows you to custom effects, by changing 

settings, adding sounds, dimming text after 
animation and different timing features. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

Enhancements 

Timing and Triggers 

Box appears for different Effect Options 

Sound files 

Options to adjust colour 
after animation 
Options to adjust colour 
after animation 
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Set up slide show   
9 If you do not want to present all the slides in the presentation, select the slides that you do not want to 

include and choose from the SLIDE SHOW tab, Hide Slide. 
9 Instead of hiding slides it sometimes is better to create different shows for different audiences based 

on your one presentation.  To custom the slides in your show, choose from the SLIDE SHOW tab, 
Custom Slide Show.  Click the drop down arrow choose Custom Shows and New.  This allows you to 
also choose which slides you want to present. Click the slides you want to use and click Add, you have 
the option to change the order of your slide.  Give your show a name and click OK.  You can Edit this 
again or create another Show based on the main presentation slides.  When you close, all the shows 
that you created are available now under the Custom Slide Show drop down menu.   

9 From the SLIDE SHOW tab, choose Set Up Slide Show.  This allows you to choose the slides in the 
show, loop the show continuously and adjust the advance slides back to manual if you were using 
timings, show without animation/ narration.   

 
Sound 
Insert Sound clips similar to Insert Video.  You can insert sound from Online Audio, Audio on My PC or 
Record Sound.  When you insert audio, the Audio Tools tabs, Format and Playback allow you to adjust 
settings.  Insert Audio and use the Audio Tools to adjust the settings.  

 
Adjust the sound to play over 5 slides- On the ANIMATION tab, select the 
Animation Pane.  On this pane, click the drop down menu on the animation 
and choose Effect Options, the Play Audio box allows you to adjust the 
settings of the Start Playing and Stop Playing.  You can choose the number of 
slides from the spin buttons.  Click OK to save the settings.   
 
Recording sounds as part of your presentation 
1. On the INSERT tab, Sound and click the drop down arrow, and click 

Record Sound. ( make sure you have microphone plugged in)  
2. Click the red circle to start recording. Click the stop button to stop 

recording. 
3. Click the play button to listen to what you have recorded. Click OK. 
4. Click the sound speaker play button to play the sound embedded in 

your presentation or run the presentation and click the icon.   
5. AUDIO TOOLS, PLAYBACK allows you to adjust the sound settings - 

provides you with Audio Options to Start Audio On Click or 
Automatically and Trim the audio you recorded.   

 
Recording Narration 
1. From the SLIDE SHOW tab choose Record Slide Show. Click Start Recording from the Beginning and click 

Start Recording.  Choose if you want to record from the Current Slide or First Slide. 
2. Begin the narration for your presentation and click to move to the next point and continue to the end. 
3. To view your timings, open in Slide Sorter view and note each slide has your narration as an Audio tool 

on the bottom right of your presentation.  You can edit each narration separately.   
4. Run the Show (F5) and it will automatically advance with your narration. 
5. Note the Record Slide Show / Clear provides you with options to remove Timings and Narration.   
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Automatic Advance 
You may wish to practice your timings and run the slide show automatically; 
1. First rehearse timings using the Rehearse Timings button in the Set up group on the SLIDE SHOW Tab. 
2. This opens up the presentation and you when you think the slide should advance, giving the audience 

adequate time to read each slide.  Click to advance. 
3. Once you have completed this, a message will appear to record the timings for use with the slide show.  

Answer Yes to this query. 
4. View the slide show to check if your timing is OK.  To bring the presentation back to manual advance, 

Set Up Slide Show option, under Advance Slides choose Manually.    
 
Importing a Word Outline into PowerPoint  
Click the drop down arrow on Insert New Slide and choose Slides from Outline.  In the Insert Outline 
dialog box Browse to find the outline file.   PowerPoint automatically imports your outline. 
 
Inserting slides from other presentations: 
Click the drop down arrow on the INSERT / New Slide and choose Reuse Slides.  A task pane opens to let 
you Browse File to the presentation that you wish to use slides from.  The presentation is opened in the 
task pane allowing you to click the slides you want to reuse.  Note the option to Keep source formatting.  
 
Printing your Presentation 
From the FILE menu, choose Print, or Press CTRL + P. In Settings, choose the option you want to print : 
Slides, Click the drop down arrow on Full Page Slides to display Notes Page or Outline or choose the 
Handouts (6 Slides Horizontal). Note also colour option. 
 
Screen Shots as Word, to insert the active Window, from the INSERT tab, click the Available Window that 
you want inserted and this is automatically inserted into your presentation.  To insert part of a window 
choose Screen Clippings and drag out the section you want to copy.  This section is automatically pasted 
into your presentation.  The PrtScn key and Paste inserts all the current screen or AtlGr key and Prt Scn key 
inserts the active window or dialog box.   
 

PowerPoint checklist   
9 Design on each slide, changing layout 9 Automatic Advance 
9 Master slide features 9 Add timing for the slides and voice over 
9 Logo and Updating date 9 Hyperlinks to web pages, files and same file links 
9 Bullets, customise, promote and demote 9 Action buttons, action settings 
9 Clipart & Drawing toolbar, Grouping 
objects 

9 Importing word outlines, slides from other 
presentations 

9 Tables Editing, merging cells……. 9 Set up show 
9 Graphs & importing charts from Excel with 
link 

9 Copying, hiding slides 
 

9 Different colour background / fonts 9 Save As different file formats  
9 Animations preset designs & customising 
 

9 Use of available Templates and creating your own 
template 

9 Transitions 9 Printing  
9 Diagrams and Organisation Charts 9 Slide Show commands 

 
 


